Excel — Formulas and Shortcuts

Creating Formulas Using the AutoSum Button I

Copying Formulas

The AutoSum button totals columns o_r'rows‘.
AutoSum Function

1. Place cursor where the answer should appear.

2. Click the AutoSum button.
3. Click green checkmark or press the

=

ENTER key. (Note: Verify the range of cells is

correct.)

L v . Formatting Numbers
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Jen Feb Map

Region #1| 34,600 35,700 32400 |=SUM(B2:D2)

Tetals

Region #2| 58000 24400 22,777

mg‘mﬁ.n wln | =

Reglon #3| 63662 63440 43619

[Reglon #4| 18708 93318

12411
Totals | - i i

Display Option

trailing decimal places.

General-The default Number format; displays
numbers without dollar signs, commas, or

If you copy é formula to a different column, the

column references in each cell address will be

incremented to the next higher letter.

e Ifyou copy to a different row, the row references
in each cell address will be incremented to the

next higher number.

—— Currency-Sets decimal places and negative
$ number display, and inserts dollar signs and

comma separators.

Percentage-Inserts percent sign to the right of a
number with a set number of decimal places.

display, and comma separator.

Comma-Set decimal places, negative number

To copy a formula:
1. Select the cell containing the formula

2. Click the handle at the lower right corner of the

cell and then drag to fill cells.
(Verify the formula copied correctly.)

Note: You can also "copy" the formula to the
clipboard and "paste" it to destination cells.

Increases number of decimal places

Decreases number of decimal places.

Examplcs of Other Functions

]

1. Select cell or range of
cells to be formatted.

2. Click on a number
formatting button.

‘General

Numbet

(Use pull-down arrow to| | Humber

$ % | %

Function formulas begin with an equal sign. (=)

Parentheses identify the “range.” Multiple ranges
can be separated by a comma. Some of the most

common functions are:

reveal more choices.)

1

Constrilcting Formulas Using Cell Addresses j

Formulas begin with an equal sign (=)
Addition ; +
Subtraction -
Division /
Multiplication #

Examples: =A1*A2 =B10/B14

=b10+b4+b5

Note: Formulas begin with an = sign.

1. Move your cursor to the cell where you would

like the answer to appear.

2. Type the formula manually or use the point and

click method to write a formula.

3. Press ENTER key or click green checkmark.

Function Code
Sum =SUM(A5:A16) -
Average =AVERAGE(A5:A16)
Maximum =MAX(A5:A16) '
Minimum =MIN(A5:A16)
The current date =TODAY()

i
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1 Jan Feb Mer Totals
2 [Region #1| 34600 35700 | 82400 $102,700 ||
'3 |Region #2 58,000 ' 24 400 22777 $105,177 | i
4 |Reglon#3| 63662 | 63440 | 43519 $170,721 |
5 [Region#4| 18708 | 23318 12411 § 54437 |
6 | Totals $174,970 | $146,858 | $111,207 | $433,035 !
7 |Average | $ 4374318 36715 § 27,802 | $108,250 |
8 |High $ 63,662 | ' $ 63440 $ 43619  $170,721 |
9 |Low - $ 18708 l $ 23318 ! 371_124'{[1#1_”@ §{1_"{l_’:j_,
10 o o
1
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Excel — Formulas and Shortcuts

[ Order of Precedence in Calculations | L Using Dates in Formulas
‘When you work with formulas that have more than Dates and times can used to create formulas. For
one arithmetic operator, the calculations are done in example, to determine the difference between two
sequence based on these rules: dates, you can subtract one date from the other. You
can add a number to an existing date and it will
1. Calculation of any exponents calculate the new date for you.
2. Multiplication and Division, left to right Example:
3. Addition and Subtraction, left to right A B it S W) E
1 Invoice |Order Date Due Date formula
Operations inside parentheses are calculated before 2 | #1001 5/22/2012| 6/21/2012 =B2+30
any other calculations. 3 | #1002 6/15/2012( 7/15/2012|  |=B34+30
Sl =] X =] =bl+b2+b3+bd/a 4 #1003 6/29/2012|7/29/2012  [=B4+30
[ A | B | © ] D I E 5 | #1004 7/1/2012|7/31/2012 =h5+30
1 |Region 1 200 S
2 |Region 2 300/
EN — & it
7; Rggmn - E‘ﬂgé+b4f4 "*ﬁ“ :‘i:» Column Width Adlustments
8 ] .
Ao o
These two formulas will calculate differently. |FE]1

=b1+b2+b3+b4/4 and =(b1+b2+b3+b4)/4
1. Slide the mouse pointer slowly across the vertical
line between column letters (grey header area)

Absolute Cell Addresses | until you see a sizing arrow.
2. Click and drag to the right to make the column

An absolute cell address used in a formula always wider or to the left to make it smaller.
remains the same, even if you move or copy the
formula to a new location. You can AUTOFIT a column by double-clicking on

, the vertical line. Excel will automatically do a "fit to
You may identify the absolute cell references by the widest item" currently in the column.
placing a dollar sign ($) before the column letter
and/or before the row number of the cell address (for Click and drag over multiple column letters to size
example, $AS$1). multiple columns simultaneously.
Pressing the F4 key adds $$ to the cell address. Page Layout = Page Layout tab / Orientation

Margins = Page Layout / Margins

Rate = .50 (reimbursement per mile) Print Gridlines/Titles = Page Layout Print Titles

Name Miles | Reimbursement

Employee #1 | 480 $ AutoFill

Employee #2 | 260 1. Type a month, day, date, or text and # in a cell.

$
Employee #3 | 382 $ (example: Check #101)
Employee #4 | 188 $ 2. Rest pointer on the handle at the lower right

corner of the cell until a + appears. Then drag to

fill cells.

Sheet Tabs
1. Double-click a sheet tab Move one or more cells
2. Type a new name for the sheet/Enter 1. Select cell or cells

(Drag a sheet tab to move sheets in a workbook). 2. Click on the outer edge ofthg cell (not the
corner) and drag to new location

[ouge



; Excel — Sorts & Filters

e Tabs are used to perform tasks.
| re W et | oein | ot [ st | sttt [ e [ v |
o “Ribbons” replace toolbars

@JE@Z’;‘ | J :

G| s D7D Ssyn|A:
Gphasrd Sl Fend

: Simple Sort

1. Click to select the Data tab

2. Select a single cell in the column
you want to sort on P sy

3. Click AZ (ascending) or ZA (descendmg)

Data can be sorted by text, values, dates, and times.
Data must be formatted properly to perform sorts.

Cell format Example Description
Text Jones Cells formatted as "text” can ba sorted alphabetically
Cumrency $200.00|Used for money values—decimals align
Number 200.00]Used for general display of numbers
Accounting S 200.00 |lines up the cumrent symbol and the decimal point
Date 11/11/2007 | Variety of date formats that allow sods or filters

Sort Based on Several Criteria

1. Click on the Sort button ' | 2 :

2. Choose: ' sort I
a. Column for 1% sort B
b. Sort On (type of sort)
c. Order

3. Click “Add Level “

4. Repeat Steps 2 & 3 as needed ) addLevel
[V, by datahas headers
Is«wn Io:da [
<] oo <] [awz 1=l

Add Level Creates additional sort criteria
Delete Level Removes a level from sort criteria list
Copy Level (Select a level before making a copy)

Sorts can be performed on text, values, dates, & times

Sort by Custom Lists

1. Type the new sort order in blank cells
(Example: Sort order = High Medium Low)
Default alphabetic options cannot be used

2. Click on File / Options / Advanced / Edit

3. Click Add

4. Type entries in the sort order that you would like to

create for new sorts

OR .

1. Click Data tab ' |

2. Sort button ’

3. Complete Column, Sort On preferences

4. Click the “Order” pull-down arrow

5. Choose Custom List ...

6. Click Add button and type list in new sort order / OK

v" “My data has headers” if first row includes labels

i[ sant =>=)

|| Crzsotess ) X psetmions) [zt | [2][= | (oot l (@ ¥y dota s hesders
Colurn iSartOn |
S'_Jr'til.wA Date [x] [vabes 2] auesmnemst =]
Thenby [Type [T [vatees =] |[awz =]

Zioa

Things to keep in mind:

Cells must be formatted correctly Excel sort or filter
actions will only include data that is formatted as
requested.

Unhide rows and columns before you sort Hidden
columns are not moved when you sort columns, and
hidden rows are not moved when you sort rows.
Enter column headings in only one row If you need
multiple line labels, wrap the text within the cell.

To exclude the first row of data from the sort because it
is a column heading, on the Home tab, in the Editing
group, click Sort & Filter, click Custom Sort and then
select My data has headers ‘

If keeping the original order of records is important,

consider inserting a sequence column so it is easy to
restore a list of records back to its original order. (Auto
fill can be used to quickly generate a sequence of text

-and numbers.)

**Note: If you do not save the file after performing a
sort, the records will remain in the original order.

//)ﬂyee 3



Sort by a partial value in a column

The “Convert Text to Columns Wizard” can split data in a
single column into multiple columns. If you are splitting one
column of text, you may want to add a blank column(s)
before performing the split.

Examples:
e last name and first name are in one column

(Mary Jones with a space between names or Jones, Mary

with a comma between names)
Your sort request on last name
e Code 412-MMF-44 (Sort request for 44 data endings)

1. Add a blank column(s) after the column that
contains the data that will be split

AutoFilter Records

1. Click Data tab 1?
2. Click Filter button at the top of a column

3. Choose appropriate filter choices / OK Filter
4. Repeat on other columns to add more criteria

Clear Filter
1. Click Data tab
2. Click Clear Filter button

Custom Auto Filter

1. Click Data tab

2. Click Filter / AutoFilter

3. Click a pull-down arrow; choose “Custom”

(Make multiple choices to perform a “custom” filter)

. Select the text to be converted
Click the Data tab

2
3. Print
4. Click the “Text to Column” button 1 rmClick File tab
5. Delimited will be the default / Next | & o . :
" ” | 2. Click Print / Print
6. Add a checkmark next to “space” or
other delimiter in your data / Next LS
(“space” in example-Mary Jones in :Columnsi Print Adjostments
P P y Click Page Layout tab to view available options.
one column) ‘ o R b )
rt s Wi Fre 21x| Insert | Page Layout | Formulas Data Review

= 2 S |
This sgeen lets ywsetﬂ'ceddmtersyowdatamnmxs You can see how your textis affected in

the preview below. N — }'3‘ 1 = EEYS =18
Delnitery o = lj i@ "= '_cr-%! —’j]
52;,,0" [ Treat consecutive delmiters s one Ma:gins Orien:ation Sivze :rintv Brejks Background ]g;i'nt
rc Text qualifier: [ .] rea itles
[V space sl : ~ PageSstup o
I~ Other: l_
et *Margins *Qrientation (Portrait/Landscape)
*Size of paper *Print area (Set or clear print area)

ary [ones . .

cate f{ilson *Breaks *Print Titles

usan fhite

ezxy {Jones

Esan Rble - .

i Print Titles

Cncd || <Bak | [ mexts Frish 1. Page Layout tab /Print Titles

2. Click Sheet tab
3. Click the “range finder” button g
- next to “Rows to repeat at top:” J

7. Answer prompts ln Iast wmdow/ lesh

S 4. Select cell Al or other appropriate line
data format 5. Click the “range finder” button again to return to
~
- Generel ‘General converts numeric values to numbers, date values to the spreadsheet/ OK
Text dates, and all remaining values to text.
 Date: IMDY ‘vl Advanced... | Page Setu E
"Donotmportmhm(dop)
= Page I Margns | HeaderfFooter | Sheet I
5 = 7 Printarea: | - _SE[
Print titles
- Rowstorepeatattop: [s1:8  E8[
:' Columns torepeat atleft: | ] E,ﬁ
Print
_ﬂll [E;-;!:‘ﬁ“e’ Comments:  |(None) =l
| Black and white
£ Cell ¥ d hd
Cancel <Back iext > I [ Emsn | I~ Draft quality SIYors 2s I@,"‘E =l
™' Row and column headings
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| AutoFill

Enter date, day, month, or
text + value / drag “fill
handle”

AutoFill a series

Enter 2 or more dates or
items Select series/
drag with “fill handle” [

AutoComplete

Press Enter or & WV to
“complete” suggested fill-in

Cut, copy, or paste

Ctrl+X, Ctrl+C, and Ctrl+V

Edit cell contents

Edit in formula bar or double-
click within the cell or F2

Enter numbers as
fractions

0 + Space + fraction / Enter

Fill empty cells with
contents of 1 cell

Select cells to fill / Ctrl + R
(Right) and Ctrl+D
(Down)

Force a line break
within a cell

Alt + Enter key

“Go to” a specific
cell

F5 / cell address

Copy or move a
sheet to a new
workbook or create a
copy within the

same workbook

Right click sheet tab / Move
or Copy / Choose “new
workbook” or location / Add
checkmark to “copy” / OK

Insert multiple rows

Click and drag to select row
numbers / Right click choose
Insert

Size multiple rows

Click and drag to select rows
/ drag to size one of the rows

Insert multiple
columns

Click and drag to select
column letters / Right click
choose Insert

Size multiple

Click and drag to select

columns columns / drag to size 1
column

Move to Cell Al Ctrl + Home key

Move to last cell Ctrl + End key

Move to beginning Homis ke

of a row

Next or Previous Ctrl+PageUp or

worksheet Ctrl+PageDown

Point & Click to
enter formulas

Start writing a formula / Point
and click to select a cell (or
range) in the formula
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